
GUIDE DE L’UTILISATEUR ET SPÉCIFICATIONS

NI USB-6008/6009
Périphérique DAQ USB multifonctions alimenté par bus

Ce guide de l’utilisateur décrit comment utiliser les périphériques USB-6008 et USB-6009 d’acquisition 
de données (DAQ) de National Instruments et dresse la liste de leurs spécifications.

Les périphériques NI USB-6008/6009 offrent une connexion à huit voies d’entrée analogique (AI) 
asymétriques, deux voies de sortie analogique (AO), 12 voies d’entrée/sortie numériques ainsi qu’un 
compteur de 32 bits et une interface USB pleine vitesse. Le Tableau 1 compare les périphériques.

Tableau 1.  Comparaison entre le NI USB-6008 et le NI USB-6009

Fonctionnalité NI USB-6008 NI USB-6009

Résolution AI 12 bits différentiels, 
11 bits référencés

14 bits différentiels, 
13 bits référencés

Fréquence d’échantillonnage 
AI maximale, voie unique*

10 kÉch/s 48 kÉch/s

Fréquence d’échantillonnage 
AI maximale, voies multiples 
(ensemble)*

10 kÉch/s 48 kÉch/s

Configuration DIO Collecteur ouvert† Chaque voie est programmable 
individuellement comme collecteur 

ouvert ou signal actif†

* Dépendant du système. 
† Ce document utilise les conventions de nom NI-DAQmx. ‘Open-drain’ est appelé collecteur ouvert et ‘push-pull’ est appelé 
signal actif.
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La Figure 1 illustre les principaux composants fonctionnels des NI USB-6008/6009.

Figure 1.  Diagramme des périphériques NI USB-6008/6009
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Consignes de sécurité
Utilisez les périphériques NI USB-6008/6009 uniquement comme décrit dans ce guide de l’utilisateur.

Attention Les périphériques NI USB-6008/6009 ne doivent en aucun cas être utilisés autrement que 
ce qui est spécifié dans ce guide de l’utilisateur. Une mauvaise utilisation du périphérique peut 
s’avérer dangereuse. Si le périphérique est endommagé de quelque manière que ce soit, cela peut 
compromettre la protection de sécurité intégrée dans le périphérique. Si le périphérique est 
endommagé, contactez National Instruments pour le réparer.

Attention Ne remplacez pas de pièces et ne modifiez pas le périphérique sauf si vous suivez ce qui 
est décrit dans ce guide de l’utilisateur. Utilisez le périphérique uniquement avec le châssis, les 
modules, les accessoires et les câbles spécifiés dans les instructions d’installation. Tous les capots et 
caches de protection doivent être installés durant l’utilisation du périphérique.

Attention N’utilisez pas le périphérique dans une atmosphère explosible ou dans un environnement 
contenant des gaz ou des vapeurs inflammables. Si vous devez faire fonctionner le périphérique dans 
un environnement de ce type, il doit se trouver dans un boîtier conforme.
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Règles de compatibilité électromagnétique
Ce produit a été testé et est conforme aux exigences et limites réglementaires relatives à la compatibilité 
électromagnétique (CEM), comme l’indiquent les spécifications du produit. Ces exigences et limites 
sont conçues pour apporter une protection raisonnable contre les interférences dangereuses lorsque le 
produit est utilisé dans l’environnement électromagnétique de fonctionnement pour lequel il a été conçu.

Ce produit est conçu pour être utilisé sur des sites industriels. Il n’est pas garanti que des interférences 
dangereuses n’auront pas lieu lors d’une installation particulière, lorsque le produit est connecté à un 
objet de test ou si le produit est utilisé dans des zones résidentielles. Afin de minimiser les risques 
d’interférence des réceptions radio et télévision et de dégradation inacceptable des performances, 
installez et utilisez ce produit conformément aux instructions qui figurent dans la documentation qui 
l’accompagne.

Par ailleurs, tout changement ou modification apporté(e) au produit et n’ayant pas été expressément 
approuvé(e) par National Instruments pourrait vous priver de votre droit d’utiliser le matériel 
conformément aux règles locales applicables.

Attention Pour garantir les performances EMC spécifiées, utilisez ce produit uniquement avec des 
câbles et accessoires blindés.

Attention Ce produit risque de devenir plus sensible aux perturbations électromagnétiques dans son 
environnement de fonctionnement quand des fils de test sont attachés ou quand il est connecté à un 
objet de test.

Attention Des émissions excédant les exigences réglementaires risquent de se produire lorsque ce 
produit est connecté à un objet de test.

Attention Les changements ou modifications non approuvés expressément par National Instruments 
pourraient priver l’utilisateur de son droit d’utiliser le matériel conformément aux règles locales 
applicables.

Décompression
Les périphériques NI USB-6008/6009 sont livrés dans un emballage antistatique pour éviter les 
décharges électrostatiques (ESD). Les ESD peuvent endommager plusieurs composants du 
périphérique.

Attention Ne touchez jamais les broches exposées des connecteurs.

Pour éviter tout dommage causé par des décharges électrostatiques lors de la manipulation du 
périphérique, prenez les précautions suivantes :

• Reliez-vous à la masse à l’aide d’un ruban de mise à la terre ou en touchant un objet mis à la masse.

• Mettez l’emballage antistatique en contact avec une partie métallique du châssis de votre ordinateur 
avant de retirer le périphérique de son emballage.

Sortez le périphérique de son emballage et examinez-le pour repérer tout composant déconnecté ou tout 
autre signe d’endommagement. Contactez NI si le périphérique apparaît endommagé d’une façon 
quelconque. N’installez pas un périphérique endommagé sur votre ordinateur ou châssis.

Conservez le périphérique dans son emballage antistatique lorsque vous ne l’utilisez pas.
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Configuration des périphériques NI USB-6008/6009
Effectuez les étapes suivantes pour démarrer avec vos périphériques NI USB-6008/6009.

Remarque Pour obtenir des informations relatives au support des systèmes d’exploitation autres que 
Windows, reportez-vous au document Getting Started with NI-DAQmx Base for Linux and Mac OS X 
Users, disponible sur ni.com/manuals.

1. Installez le logiciel d’application (le  cas échéant), en suivant les instructions d’installation fournies 
avec le logiciel.

2. Installez NI-DAQmx1.

Remarque Le logiciel NI-DAQmx est inclus sur le disque livré avec votre kit et disponible pour 
téléchargement sur ni.com/support. La documentation du logiciel NI-DAQmx est disponible 
après installation, à partir de Démarrer»Tous les programmes»National Instruments»NI-DAQ. 
De la documentation supplémentaire est disponible sur ni.com/manuals.

3. Installez les connecteurs de type bornier à vis de 16 contacts en les insérant dans les jack de 
connexion, comme l’indique la Figure 2.

Figure 2.  Diagramme d’application des étiquettes de signaux

1   Les périphériques NI USB-6008/6009 sont supportés par NI-DAQmx 7.5 et versions ultérieures.
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2 Connecteur de type bornier à vis
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4. Collez les étiquettes de signaux fournies aux connecteurs de type bornier à vis. Vous pouvez choisir 
des étiquettes ayant des numéros de broches, des noms de signaux ou des étiquettes vierges, comme 
l’indique la Figure 3. Choisissez l’étiquette correcte, alignez-la aux borniers imprimés qui se 
trouvent sur la face supérieure de votre périphérique puis appliquez l’étiquette, comme le montre 
la Figure 2. 

Figure 3.  Étiquettes de signaux des périphériques NI USB-6008/6009

Remarque Une fois que vous avez étiqueté les connecteurs de type bornier à vis, vous ne devez les 
insérer que dans les jack de connexion correspondants, comme l’indique l’étiquette du calque située 
sur le périphérique.

5. Branchez l’une des extrémités du câble USB aux NI USB-6008/6009 et l’autre extrémité à un port 
USB disponible sur votre ordinateur.

6. Double-cliquez sur l’icône Measurement & Automation, représentée à gauche, située sur le 
bureau pour ouvrir Measurement & Automation Explorer (MAX).

7. Développez Système»Périphériques et interfaces et vérifiez que les NI USB-6008/6009 sont 
listés. Si votre périphérique n’apparaît pas, appuyez sur <F5> pour rafraîchir l’affichage dans 
MAX. Si votre périphérique n’est toujours pas reconnu, reportez-vous à la page ni.com/
support/daqmx pour obtenir des informations de dépannage.

8. Effectuez un auto-test sur votre périphérique dans MAX, en cliquant avec le bouton droit sur 
NI USB-600x puis sélectionnez Auto-test. L’auto-test effectue un test rapide pour confirmer que 
le périphérique est correctement installé. Au terme de l’auto-test, un message s’affiche, indiquant 
si la vérification s’est déroulée sans problème ou si une erreur a eu lieu. Si une erreur s’est produite, 
reportez-vous à ni.com/support/daqmx.

Attention Pour garantir les performances EMC spécifiées, utilisez ce produit uniquement avec des 
câbles et accessoires blindés.

9. Connectez les fils (16 à 28 AWG) d’un câble blindé, multiconducteur aux borniers à vis en enlevant 
l’isolation sur une longueur de 6,35 mm (0,25 pouces), en insérant les fils aux borniers à vis, puis 
en ressérant fermement les vis au couple de 0,22–0,25 N · m (2,0–2,2 livres-pouces) avec un 
tournevis à lame plate. Reportez-vous à la Figure 6 pour obtenir le brochage des 
NI USB 6008/6009.

Si vous utilisez un câble blindé, connectez le blindage du câble à un terminal GND à proximité.

1 Étiquette personnalisée définie par 
l’utilisateur

2 Étiquette du numéro de bornier
3 Étiquette d’E/S numériques

4 Étiquette du nom des signaux différentiels d’entrée
analogique

5 Étiquette du nom des signaux asymétriques d’entrée 
analogique

GND + AI0 - + AI1 - + AI2 - + AI3 - AO0 AO1 GND

GND +5V +2.5VPFI0 P1.3 P1.2 P1.1 P1.0 P0.7 P0.6 P0.5 P0.4 P0.3 P0.2 P0.1 P0.0

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16
GND AI0 AI4 GND AI1 AI5 GND AI 2 AI6 GND AI3 AI7 GND AO0 AO1 GND
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Remarque Pour obtenir des informations sur les capteurs, reportez-vous à ni.com/sensors. 
Pour en savoir plus sur les capteurs intelligents TEDS IEEE 1451.4, consultez ni.com/teds.

10. Effectuez un auto-test dans MAX, en cliquant avec le bouton droit sur NI USB-600x puis 
sélectionnez Auto-test.

Cliquez sur Démarrer pour tester les fonctions du périphérique ou sur Aide pour obtenir des 
instructions d’utilisation. Cliquez sur Fermer pour quitter les panneaux de test.

Utilisation des périphériques NI USB-6008/6009 dans une application
Vous pouvez utiliser l’Assistant DAQ depuis de nombreux programmes logiciels d’application de NI 
afin de configurer des voies virtuelles et de mesure. Le Tableau 2 répertorie les emplacements du tutoriel 
de l’Assistant DAQ pour les applications NI.

Reportez-vous à la section Et maintenant ? pour obtenir des informations relatives aux exemples de 
programmation pour NI-DAQmx et NI-DAQmx Base.

Tableau 2.  Emplacements du tutoriel de l’Assistant DAQ

Application NI Emplacement du tutoriel

LabVIEW Sélectionnez Aide»Aide LabVIEW. Ensuite, sélectionnez Initiation à 
LabVIEW»Initiation à DAQ»Prendre une mesure NI-DAQmx dans 
LabVIEW.

LabWindows™/CVI™ Sélectionnez Aide»Sommaire. Ensuite, sélectionnez Using LabWindows/CVI»
Data Acquisition»Taking an NI-DAQmx Measurement in LabWindows/CVI.

Measurement Studio Sélectionnez NI Measurement Studio Help»Getting Started with the 
Measurement Studio Class Libraries»Measurement Studio Walkthroughs»
Walkthrough: Creating a Measurement Studio NI-DAQmx Application.

LabVIEW SignalExpress Sélectionnez Aide»Prendre une mesure NI-DAQmx dans 
LabVIEW SignalExpress
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Fonctionnalités
Les périphériques NI USB-6008/6009 disposent d’un connecteur USB, de maintien de câble USB, de 
deux connecteurs de type bornier à vis pour les E/S ainsi que d’un indicateur LED, comme l’indique la 
Figure 4.

Figure 4.  Vues du haut et de l’arrière des périphériques NI USB-6008/6009

Connecteur USB et maintien de câble USB
Les périphériques NI USB-6008/6009 disposent d’un connecteur USB pour une interface USB pleine 
vitesse. Vous pouvez maintenir le câble USB en enfilant une attache dans la bague de maintien du câble 
puis en ressérant autour un câble USB en forme de boucle, comme l’indique la Figure 5.

Figure 5.  Maintien des périphériques NI USB-6008/6009

1 Maintien de câble USB
2 Connecteur de type bornier à vis

3 Indicateur LED
4 Connecteur USB
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Indicateur LED
Les périphériques NI-USB 6008/6009 disposent d’un indicateur LED vert qui indique l’état du 
périphérique, comme le montre le Tableau 3. Lorsque le périphérique est connecté à un port USB, la 
LED clignote pour indiquer que le périphérique est initialisé et alimenté par la connexion.

Connecteurs de type bornier à vis
Les périphériques NI USB-6008/6009 sont livrés avec un connecteur de type bornier à vis amovible 
pour les signaux analogiques et un pour les signaux numériques. Ces connecteurs de type bornier à vis 
offrent 16 connexions qui utilisent des fils 16–28 AWG. Reportez-vous à l’étape 4 de la section 
Configuration des périphériques NI USB-6008/6009 pour obtenir des informations relatives à la 
sélection d’étiquettes pour les connecteurs de type bornier à vis. Reportez-vous à la section Description 
du brochage et des signaux pour obtenir la description du brochage et des signaux du périphérique.

Vous pouvez commander des connecteurs et étiquettes supplémentaires pour votre périphérique. 
Reportez-vous à la section Câbles et accessoires pour obtenir des informations.

Firmware
Le firmware des NI USB-6008/6009 se rafraîchit dès lors que les périphériques sont connectés à un 
ordinateur ayant NI-DAQmx. NI-DAQmx charge automatiquement la version du firmware compatible 
avec le périphérique. La version du firmware peut être mise à jour dès qu’une nouvelle version de 
NI-DAQmx est publiée.

Tableau 3.  Statut de la LED et du périphérique

Statut de la LED Statut du périphérique

Non allumée Périphérique non connecté ou arrêté

Allumée, ne 
clignote pas

Périphérique connecté mais non initialisé, ou ordinateur en mode veille. 

Pour que le périphérique soit reconnu, il doit être connecté à un ordinateur ayant 
NI-DAQmx installé.

Clignote une fois Fonctionne normalement
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Câbles et accessoires
Le Tableau 4 contient des informations sur les câbles et accessoires disponibles pour les périphériques 
NI USB-6008/6009. Pour obtenir une liste complète des accessoires et demander des informations, 
reportez-vous à la section Prix de la page produits du NI USB-6008 ou NI USB-6009 sur ni.com.

Description du brochage et des signaux
La Figure 6 montre le brochage des périphériques NI USB-6008/6009. Les noms de signaux d’entrée 
analogique sont répertoriés comme noms d’entrée analogique (AI) asymétrique, AI x, suivis du nom de 
l’entrée analogique différentielle, (AI x+/–). Reportez-vous au Tableau 5 pour obtenir une description 
détaillée de chaque signal.

Figure 6.  Brochage des périphériques NI USB-6008/6009

Tableau 4.  Câbles et accessoires des périphériques NI USB-6008/6009

Accessoire Référence Description

Kit d’accessoires USB 6008/09 779371-01 Quatre connecteurs de type bornier à vis et étiquettes de 
connecteurs supplémentaires et un tournevis

Accessoire de prototypage de la série 
NI USB-6000

779511-01 Accessoire non blindé de prototypage pour le conditionnement 
de signal et le prototypage personnalisés. Vous pouvez utiliser 
jusqu’à deux accessoires par périphérique.

Câble USB haute vitesse 184125-01 
184125-02

1m de long
2m de long

Attention : Pour assurer la conformité aux exigences de compatibilité électromagnétique (CEM), ce produit doit être 
connecté par des câbles et des accessoires blindés. Si des câbles ou des accessoires non blindés sont utilisés, les spécifications 
EMC ne sont plus garanties, sauf si tous les câbles et/ou accessoires non blindés sont installés dans une enceinte blindée 
dotée de ports d’entrée/sortie blindés correctement conçus.
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Tableau 5.  Description des signaux

Nom du 
signal Référence Direction Description

GND — — Masse — Le point de référence pour les mesures d’entrée analogique 
asymétriques, les tensions de sortie analogique, les signaux numériques, 
l’alimentation de +5 VCC et de +2,5 VCC au connecteur d’E/S, et le 
point de retour des courants de polarisation pour les mesures 
différentielles.

AI <0..7> Varie Entrée Voies d’entrée analogique 0 à 7 — Pour les mesures asymétriques 
référencées, chaque signal est une voie de tension d’entrée analogique. 
Pour les mesures différentielles, AI 0 et AI 4 sont les entrées positive et 
négative de la voie d’entrée analogique différentielle 0. Les paires de 
signaux suivantes forment également des voies d’entrée différentielles : 
AI<1, 5>, AI<2, 6> et AI<3, 7>. Reportez-vous à la section Entrée 
analogique pour obtenir de plus amples informations.

AO <0, 1> GND Sortie Voies de sortie analogique 0 à 1 — Fournit la sortie de tension de la voie 
de sortie analogique 0 ou 1. Reportez-vous à la section Sortie analogique 
pour plus d’informations.

P0.<0..7> GND Entrée ou sortie Port 0, voies d’E/S numériques 0 à 7 — Vous pouvez configurer 
individuellement chaque signal comme entrée ou sortie. Reportez-vous à 
la section E/S numériques pour obtenir de plus amples informations.

P1.<0..3> GND Entrée ou sortie Port 1, voies d’E/S numériques 0 à 3 — Vous pouvez configurer 
individuellement chaque signal comme entrée ou sortie. Reportez-vous à 
la section E/S numériques pour obtenir de plus amples informations.

PFI 0 GND Entrée PFI 0 — Cette broche est configurable comme déclenchement 
numérique ou comme entrée de compteur d’événements. Reportez-vous 
à la section PFI 0 pour obtenir de plus amples informations.

+2,5 V GND Sortie Référence externe +2,5 V — Fournit une référence pour du test par 
rebouclage. Reportez-vous à la section Référence externe de +2,5 V pour 
obtenir de plus amples informations.

+5 V GND Sortie Source d’alimentation +5 V — Fournit une alimentation de +5 V 
jusqu’à 200 mA. Reportez-vous à la section Source d’alimentation de 
+5 V pour obtenir de plus amples informations.
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Entrée analogique
Les périphériques NI USB-6008/6009 disposent de huit voies d’entrée analogique que vous pouvez 
utiliser pour effectuer quatre mesures d’entrée analogique différentielles ou huit mesures d’entrée 
analogique asymétriques.

La Figure 7 illustre le circuit d’entrée analogique des périphériques NI USB-6008/6009.

Figure 7.  Circuit d’entrée analogique des périphériques NI USB-6008/6009

Les principaux blocs qui composent le circuit d’entrée analogique des périphériques NI USB-6008/6009 
sont les suivants :

• MUX — Les périphériques NI USB-6008/6009 disposent d’un convertisseur 
analogique/numérique (C A/N). Le multiplexeur (MUX) assure le routage d’une voie AI à la fois 
vers le PGA.

• PGA — L’amplificateur de gain programmable fournit des gains d’entrée de 1, 2, 4, 5, 8, 10, 16 ou 
20 lorsqu’il est configuré pour effectuer des mesures différentielles et un gain de 1 lorsqu’il est 
configuré pour des mesures asymétriques. Le gain PGA est automatiquement calculé sur la base de 
la gamme de tension sélectionnée dans l’application de mesure.

• C A/N— Le convertisseur analogique/numérique (C A/N) numérise le signal AI en convertissant 
la tension analogique en code numérique.

• AI FIFO — Les périphériques NI USB-6008/6009 peuvent effectuer des conversions 
analogiques/numériques simples et multiples d’un nombre fixe ou infini d’échantillons. Un buffer 
FIFO (First-In-First-Out) contient les données durant les acquisitions AI pour assurer qu’aucune 
donnée n’est perdue.

Modes d’entrée analogique et sources de signaux
Vous pouvez configurer les voies AI des périphériques NI USB-6008/6009 pour effectuer des mesures 
asymétriques différentielles ou référencées (RSE). Le Tableau 6 synthétise le(s) mode(s) d’entrée 
analogique recommandé(s) pour les sources de signaux flottantes et celles référencées à la masse. 
Reportez-vous au Tableau 5 afin d’obtenir des informations complémentaires sur les connexions d’E/S 
pour des mesures asymétriques ou différentielles.

AI

+2,5 VREF

39,2 kΩ

127 kΩ

30,9 kΩ PGA

Sélection de la
gamme d’entrée

AI FIFOC A/NMUX
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Sources de signaux flottantes
Une source de signal flottante n’est pas connectée à la terre du bâtiment, mais dispose d’un point de 
référence à la masse isolé. Quelques exemples de sources de signaux flottantes sont les sorties de 
transformateurs, les thermocouples, les appareils alimentés par piles, les isolateurs optiques et les 
amplificateurs d’isolement. Un instrument ou un périphérique qui possède une sortie isolée est une 
source de signal flottante.

Pour plus d’informations, reportez-vous au document Field Wiring and Noise Considerations for 
Analog Signals sur NI Developer Zone. Pour accédez à ce document, allez sur ni.com/frinfo et 
entrez l’info-code rdfwn3.

À quel moment utiliser des connexions différentielles avec des sources de signaux flottantes ?
Utilisez des connexions d’entrée DIFF pour toute voie répondant à l’une des conditions suivantes :

• Votre application nécessite des gammes d’entrée autres que ±10 V.

• Le signal en entrée est faible et nécessite une plus grande précision.

• Les fils conducteurs connectant le signal au périphérique sont supérieurs à 3 m (10 pieds).

Tableau 6.  Configuration de l’entrée analogique

Mode d’entrée 
analogique

Sources de signaux flottantes 
(non connectées à la terre du 

bâtiment)
Sources de signaux référencées à 

la masse

Exemples :

• Thermocouples non mis à la masse

• Conditionnement de signal avec 
sorties isolées

• Appareils alimentés par piles

Exemple :

• Appareils alimentés par piles avec 
sorties non isolées

Différentielle (DIFF)

Asymétrique 
référencée à la masse 
(RSE)

+
–

+

–

AI+ 

AI– 

GND

Source de signal NI USB-6008/6009

+
–

+

–

AI+ 

AI– 

GND

Source de signal NI USB-6008/6009

+
–

+

–

AI 

GND

Source de signal NI USB-6008/6009

La tension de boucle de mise à la masse (TA – TB)
est ajoutée au signal mesuré.

NON RECOMMANDÉ

+
–

+

–

AI 

GND
TB

TA

Source de signal NI USB-6008/6009
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• Le signal en entrée nécessite un point de référence à la masse ou un signal renvoyé séparé.

• Les fils conducteurs des signaux passent dans des environnements bruyants.

• Deux voies d’entrée analogique, AI+ et AI–, sont disponibles pour le signal.

Les connexions de signaux DIFF réduisent le bruit capté et augmentent la réjection du bruit de mode 
commun. Les connexions de signaux DIFF permettent également aux signaux d’entrée de flotter dans 
la tension de fonctionnement du périphérique.

Reportez-vous à la section Prise de mesures différentielles pour obtenir de plus amples informations sur 
les connexions différentielles.

À quel moment utiliser des connexions asymétriques référencées (RSE) avec des sources de signaux 
flottantes ?
N’utilisez des connexions d’entrée RSE que si le signal en entrée répond aux conditions suivantes :

• Le signal en entrée peut partager un point de référence commun, GND, avec d’autres signaux 
utilisant le mode RSE.

• Votre application permet l’utilisation de la gamme d’entrée de ±10 V.

• Les fils conducteurs connectant le signal au périphérique sont inférieurs à 3 m (10 pieds).

Les connexions d’entrée DIFF sont recommandées afin de maximiser l’intégrité du signal pour tout 
signal d’entrée ne répondant pas aux conditions ci-dessus.

Dans les modes asymétriques, davantage de bruit électrostatique et magnétique s’ajoute aux connexions 
de signaux que dans des configurations DIFF. Le couplage est le résultat de différences dans le chemin 
du signal. Le couplage magnétique est proportionnel à la zone entre les deux conducteurs de signaux. 
Le couplage électrique est fonction de la différence de champ électrique existante entre les deux 
conducteurs.

Avec ce type de connexion, le PGA rejette aussi bien le bruit de mode commun dans le signal que la 
différence potentielle de masse entre la source du signal et la masse du périphérique.

Reportez-vous à la section Prise de mesures asymétriques référencées pour obtenir de plus amples 
informations sur les connexions RSE.

Sources de signaux référencées à la masse
Une source de signal référencée à la masse est une source connectée à la terre d’un bâtiment. Elle est 
déjà connectée au même point de masse que le périphérique, en supposant que l’ordinateur soit branché 
au même système d’alimentation que la source. Les sorties non isolées d’instruments et de 
périphériques, qui se branchent au système d’alimentation d’un bâtiment, font partie de cette catégorie.

La différence de potentiel de masse entre deux instruments connectés au même système d’alimentation 
d’un bâtiment est généralement comprise entre 1 et 100 mV, mais elle peut être bien plus élevée si les 
circuits de distribution d’alimentation sont incorrectement connectés. Si une source de signal mise à la 
masse n’est pas mesurée correctement, la différence peut causer une erreur de mesure. Veuillez suivre 
les instructions de connexion pour les sources de signaux mises à la masse afin d’éliminer cette 
différence potentielle de masse du signal mesuré.

Pour plus d’informations, reportez-vous au document Field Wiring and Noise Considerations for 
Analog Signals sur NI Developer Zone. Pour accédez à ce document, allez sur ni.com/frinfo et 
entrez l’info-code rdfwn3.
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À quel moment utiliser des connexions différentielles avec des sources de signaux référencées à la 
masse ?
Utilisez des connexions d’entrée DIFF pour toute voie répondant à l’une des conditions suivantes :

• Votre application nécessite des gammes d’entrée autres que ±10 V.

• Le signal en entrée est faible et nécessite une plus grande précision.

• Les fils conducteurs connectant le signal au périphérique sont supérieurs à 3 m (10 pieds).

• Le signal en entrée nécessite un point de référence à la masse ou un signal renvoyé séparé.

• Les fils conducteurs des signaux passent dans des environnements bruyants.

• Deux voies d’entrée analogique, AI+ et AI–, sont disponibles pour le signal.

Les connexions de signaux DIFF réduisent le bruit capté et augmentent la réjection du bruit de mode 
commun. Les connexions de signaux DIFF permettent également aux signaux d’entrée de flotter dans 
la tension de fonctionnement du périphérique.

Reportez-vous à la section Prise de mesures différentielles pour obtenir de plus amples informations sur 
les connexions différentielles.

À quel moment utiliser des connexions asymétriques référencées (RSE) avec des sources de signaux 
référencées à la masse ?
N’utilisez pas de connexions RSE avec des sources de signaux référencées à la masse. Utilisez plutôt 
des connexions différentielles.

Comme l’indique la cellule inférieure de droite du Tableau 6, une différence potentielle entre GND et la 
masse du capteur peut exister. En mode RSE, cette boucle de mise à la masse provoque des erreurs de 
mesure.

Prise de mesures différentielles
Pour les signaux différentiels, connectez le fil conducteur positif du signal au terminal AI+ et le fil 
conducteur négatif au terminal AI–.

Figure 8.  Connexion d’un signal de tension différentiel

Le mode d’entrée différentiel peut mesurer des signaux de ±20 V dans la gamme de ±20 V. Cependant, 
la tension maximale de n’importe quelle broche est de ±10 V par rapport à GND. Par exemple, 
si AI 1 est de +10 V et AI 5 de –10 V, la mesure renvoyée par le périphérique est donc de +20 V.

AI+

NI USB-6008/6009

AI–

Source de
tension
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Figure 9.  Exemple d’une mesure différentielle de 20 V

La connexion d’un signal supérieur à ±10 V sur l’une des broches entraîne une sortie écrêtée.

Figure 10.  Excéder ±10 V sur une AI renvoie une sortie écrêtée

Prise de mesures asymétriques référencées
Pour connecter des signaux de tension asymétriques référencés (RSE) aux périphériques 
NI USB-6008/6009, connectez le signal de tension positif à un terminal AI et le signal mis à la masse à 
un terminal GND, comme l’indique la Figure 11.

Figure 11.  Connexion d’un signal de tension asymétrique référencé
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Lorsqu’aucun signal n’est connecté au terminal d’entrée analogique, le diviseur de résistance interne 
peut entraîner le terminal à flotter à approximativement 1,4 V quand le terminal d’entrée analogique est 
configuré en mode RSE. Ce comportement est normal et n’affecte pas la mesure quand un signal est 
connecté.

Déclenchement numérique
Vous pouvez configurer PFI 0 comme entrée de déclenchement numérique pour des tâches d’entrée 
analogique. Reportez-vous à la section Utilisation de PFI 0 comme déclenchement numérique pour 
obtenir de plus amples informations.

Sortie analogique

Les périphériques NI USB-6008/6009 disposent de deux voies de sortie analogique indépendantes qui 
peuvent générer des tensions de sortie comprises entre 0 et 5 V. Toutes les mises à jour de voies de sortie 
analogique sont cadencées par logiciel. GND est le signal de référence à la masse pour les voies de sortie 
analogique.

La Figure 12 illustre le circuit d’une voie de sortie analogique des périphériques NI USB-6008/6009. 

Figure 12.  Circuit d’une voie de sortie analogique

Le principal bloc qui compose le circuit de sortie analogique des périphériques NI USB-6008/6009 est 
le convertisseur numérique/analogique (C N/A), qui convertit des codes numériques en tensions 
analogiques. Il existe un C N/A pour chaque ligne de sortie analogique.

Connexion de charges de sortie analogique
Pour connecter des charges aux périphériques NI USB-6008/6009, connectez le fil conducteur positif 
de la charge au terminal AO et connectez la masse de la charge à un terminal GND, comme l’indique la 
Figure 13.

Figure 13.  Connexion d’une charge

REF(+) REF(–)
C N/A
12 bits

50 Ω
AO

+5 V

GND

NI USB-6008/6009

GND

AO

Charge
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Minimisation des impulsions transitoires sur le signal de sortie
Lors de l’utilisation d’un C N/A pour générer un signal, il est possible d’observer des impulsions 
transitoires sur le signal de sortie. Ces impulsions transitoires sont normales ; quand un C N/A passe 
d’une tension à une autre, il produit des impulsions transitoires dues à la libération de charges. Les 
impulsions transitoires les plus importantes se produisent quand le bit le plus significatif du code du 
C N/A change. Vous pouvez construire un filtre passe-bas afin de supprimer certaines impulsions 
transitoires, selon la fréquence et la nature du signal en sortie. Pour obtenir des informations 
complémentaires sur la minimisation des impulsions transitoires, reportez-vous au document de la Base 
de connaissances Reducing Glitches on the Analog Output of MIO DAQ Devices. Pour accédez à ce 
document, allez sur ni.com/frinfo et entrez l’info-code exszek.

E/S numériques
Les périphériques NI USB-6008/6009 disposent de 12 lignes numériques sur deux ports. Le Port 0 
possède huit lignes, P0.<0..7>, et le Port 1 en possède 4, P1.<0..3>. GND est le signal référencé à la 
masse pour les ports d’E/S numériques. Vous pouvez programmer individuellement toutes les lignes 
comme entrées ou sorties.

La Figure 14 montre P0.<0..7> connecté à des signaux d’exemple configurés comme entrées 
numériques et sorties numériques. Vous pouvez configurer P1.<0..3> de la même manière.

Figure 14.  Exemple de connexion d’une charge

Attention Le dépassement des spécifications de tension maximale en entrée ou en sortie, listées à la 
section Spécifications, peut endommager le périphérique ainsi que l’ordinateur. National Instruments 
ne peut être tenu responsable de tout dommage résultant de telles connexions de signaux.

1 P0.0 configuré comme sortie numérique d’un collecteur ouvert, qui contrôle une LED
2 P0.2 configuré comme sortie numérique d’un signal actif, qui contrôle une LED
3 P0.4 configuré comme entrée numérique recevant un signal TTL à partir d’un inverseur à déclenchement logique.
4 P0.7 configuré comme entrée numérique recevant un signal de 0 V ou de 5 V à partir d’un commutateur

+5 V

LED

Commutateur

Connecteur d’E/S
GND

P0.0
P0.1
P0.2
P0.3
P0.4
P0.5
P0.6
P0.7

+5 V

LED

1

2

3

4

Signal TTL

NI USB-6008/6009
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Informations sur le courant émis/absorbé
La configuration par défaut des ports d’E/S numériques des périphériques NI USB-6008/6009 est en 
mode collecteur ouvert, ce qui permet des opérations de 5 V, avec une résistance de pull-up embarquée 
de 4,7 kΩ. Une résistance de pull-up externe fournie par l’utilisateur, peut être ajoutée pour augmenter 
le courant source jusqu’à 8,5 mA par ligne, comme l’indique la Figure 15.1

Figure 15.  Exemple de connexion d’une résistance externe fournie par l’utilisateur

Les ports du périphérique NI USB-6009 peuvent aussi être configurés comme signaux actifs en utilisant 
l’API NI-DAQmx, ce qui permet des opérations de 3,3 V avec une limite de courant émis/absorbé de 
±8,5 mA. Pour obtenir des informations complémentaires sur la manière de définir la configuration 
DIO, reportez-vous au document de la Base de connaissances, Configuring NI Devices to be 
Open-Drain (Open Collector) or Push-Pull (Active Drive). Pour accédez à ce document, allez sur 
ni.com/frinfo et entrez l’info-code ex52p.

Effectuez les étapes suivantes pour déterminer la valeur de la résistance de pull-up fournie par 
l’utilisateur :

1. Placez un ampèremètre en série avec la charge.

2. Placez une résistance variable entre la ligne de sortie numérique et l’alimentation de +5 V.

3. Définissez P0.0 à haut.

4. Ajustez la résistance variable jusqu’à ce que le courant de l’ampèremètre affiche le courant prévu. 
Le courant prévu doit être inférieur à 8,5 mA.

5. Supprimez l’ampèremètre et la résistance variable de votre circuit.

6. Mesurez la résistance de la résistance variable. La résistance mesurée est la valeur optimale de la 
résistance de pull-up.

1   Ce document utilise les conventions de nom NI-DAQmx. ‘Open-drain’ est appelé collecteur ouvert et ‘push-pull’ est appelé 
signal actif.

GND

P0.0

+5 V

RpRext

Rf

NI USB-6008/6009
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A
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Point de 
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du port

Résistance embarquée de 4,7 kΩ

Résistance
depull-up

externe
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7. Sélectionnez une valeur de résistance statique pour votre résistance de pull-up, qui soit supérieure 
ou égale à la résistance optimale.

8. Reconnectez le circuit de charge et la résistance de pull-up.

Protection des E/S
Pour protéger les périphériques NI USB-6008/6009 contre les surtensions, les sous-tensions, les 
sur-intensités ainsi que les événements ESD, il est préférable d’éviter ces défaillances en respectant les 
règles suivantes :

• Si vous configurez une ligne DIO comme sortie, ne la connectez pas à une source de signal externe, 
un signal mis à la masse ou un bloc d’alimentation.

• Si vous configurez une ligne DIO comme sortie, il est important de comprendre les exigences de 
courant de la charge connectée à ces signaux. Ne dépassez pas les limites de sortie de courant du 
périphérique d’acquisition de données.

National Instruments dispose de plusieurs solutions de conditionnement de signaux pour des 
applications numériques nécessitant un courant élevé.

• Si vous configurez une ligne DIO comme entrée, ne la faites pas fonctionner avec des tensions 
en-dehors de sa gamme de fonctionnement normale. Les lignes DIO ont une gamme de 
fonctionnement plus petite que celle des signaux AI.

• Manipulez le périphérique DAQ comme vous le feriez avec tout autre périphérique sensible à 
l’électricité statique. Mettez toujours l’équipement à la masse lorsque vous manipulez votre 
périphérique d’acquisition de données ou que vous le connectez, et assurez-vous d’être vous-même 
relié à la masse.

États au démarrage
Au démarrage et à la réinitialisation du système, le matériel définit toutes les lignes DIO comme des 
entrées de haute impédance. Le périphérique DAQ ne positionne pas le signal à un état haut ou bas. 
Chaque ligne a une faible résistance de pull-up qui lui est connectée.

DIO statiques
Chacune des lignes DIO des NI USB-6008/6009 peut être utilisée comme ligne d’entrée numérique (DI) 
ou de sortie numérique (DO) statique. Vous pouvez utiliser des lignes DIO statiques pour surveiller et 
contrôler des signaux numériques. Tous les échantillons de lignes DI statiques et les mises à jour de 
lignes DO sont cadencés par logiciel.

PFI 0
PFI 0 est configurable comme entrée de déclenchement numérique ou comme entrée de compteur 
d’événements.

Utilisation de PFI 0 comme déclenchement numérique
Lorsqu’une tâche d’entrée analogique est définie, vous pouvez configurer PFI 0 comme entrée de 
déclenchement numérique. Lorsque le déclenchement numérique est activé, la tâche AI attend un front 
montant ou descendant sur PFI 0 avant de démarrer l’acquisition. Pour utiliser le déclenchement de 
démarrage (ai/StartTrigger) avec une source numérique, spécifiez PFI 0 comme source, puis 
sélectionnez un front montant ou descendant.

Utilisation de PFI 0 comme compteur d’événements
Vous pouvez configurer PFI 0 comme source de comptage de fronts numériques. Avec ce mode, les 
événements de front descendant sont comptés avec un compteur 32 bits. Pour obtenir de plus amples 
informations concernant les contraintes de cadencement d’événements, reportez-vous à la section 
Spécifications.
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Référence externe et source d’alimentation
Les périphériques NI USB-6008/6009 créent une référence externe et fournissent une source 
d’alimentation. Toutes les tensions sont relatives à la masse (GND).

Référence externe de +2,5 V
Les périphériques NI USB-6008/6009 créent une source de tension de référence à haut degré de pureté 
pour le C A/N, en utilisant un régulateur multi-états, un amplificateur et un filtre. Vous pouvez utiliser 
la tension de référence de +2,5 V résultante comme signal pour effectuer un auto-test.

Source d’alimentation de +5 V
Les périphériques NI USB-6008/6009 fournissent une sortie de 5 V, 200 mA. Vous pouvez utiliser cette 
source pour alimenter des composants externes.

Remarque Quand le périphérique est arrêté en USB, la sortie est désactivée.

Spécifications
Les spécifications suivantes sont typiques à 25 °C, sauf mention contraire.

Entrée analogique
Entrées analogiques

Différentielle ..................................................4

Asymétrique...................................................8, sélectionnable par logiciel

Résolution en entrée

NI USB-6008

Différentielle ..........................................12 bits

Asymétrique...........................................11 bits

NI USB-6009

Différentielle ..........................................14 bits

Asymétrique...........................................13 bits

Fréquence d’échantillonnage max. (ensemble)1

NI USB-6008 .................................................10 kÉch/s

NI USB-6009 .................................................48 kÉch/s

Type de convertisseur.............................................Approximations successives

AI FIFO..................................................................512 octets

Résolution de cadencement ...................................41,67 ns (base de temps à 24 MHz)

Précision de cadencement ......................................100 ppm de la fréquence d’échantillonnage réelle

Gamme d’entrée

Différentielle ..................................................±20 V2, ±10 V, ±5 V, ±4 V, ±2,5 V, ±2 V, 
±1,25 V, ±1 V

Asymétrique...................................................±10 V

1   Dépendant du système.
2   ±20 V signifie que |AI+ –(AI–)| ≤ 20 V. Cependant, AI+ et AI– doivent tous deux être compris à ±10 V de GND. Reportez-vous 

à la section Prise de mesures différentielles pour obtenir de plus amples informations.
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Tension de fonctionnement ....................................±10 V

Impédance d’entrée................................................144 kΩ

Protection contre les surtensions............................±35 V

Source de déclenchement.......................................Déclenchement logiciel ou numérique externe

Bruit du système1

Différentiel

Gamme de ±20 V...................................5 mVeff

Gamme de ±1 V.....................................0,5 mVeff

Asymétrique

Gamme de ±10 V...................................5 mVeff

Précision absolue à pleine échelle, différentielle2

Précision absolue à pleine échelle, asymétrique

Sortie analogique
Sorties analogiques ................................................2

Résolution en sortie ...............................................12 bits

Fréquence de mise à jour maximale ......................150 Hz, cadencée par logiciel

Gamme de sortie ....................................................0 à +5V

Impédance de sortie ...............................................50 Ω

Courant en sortie ....................................................5 mA

État de mise sous tension .......................................0 V

1   Bruit du système mesuré à une fréquence d’échantillonnage maximale.
2   Les tensions en entrée ne doivent pas excéder la gamme de tension de fonctionnement.

Gamme (V) Typique à 25°C (mV) Surchauffe maximale (mV)

±20 14,7 138

±10 7,73 84,8

±5 4,28 58,4

±4 3,59 53,1

±2,5 2,56 45,1

±2 2,21 42,5

±1,25 1,70 38,9

±1 1,53 37,5

Gamme (V) Typique à 25°C (mV) Surchauffe maximale (mV)

±10 14,7 138
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Vitesse de variation ................................................1 V/μs

Courant de court-circuit .........................................50 mA

Précision absolue (aucune charge)

Typique ..........................................................7 mV

Maximale à pleine échelle .............................36,4 mV

E/S numériques
Lignes d’E/S numériques

P0.<0..7>........................................................8 lignes

P1.<0..3>........................................................4 lignes

Contrôle de la direction..........................................Chaque voie est programmable individuellement 
comme entrée ou sortie

Type de pilotage en sortie1

NI USB-6008 .................................................Collecteur ouvert

NI USB-6009 .................................................Chaque voie est programmable individuellement 
comme collecteur ouvert ou signal actif

Compatibilité .........................................................TTL, LVTTL, CMOS

Gamme de tension maximale absolue ...................–0,5 à 5,8 V par rapport à GND

Résistance de pull-up .............................................4,7 kΩ à 5 V

État de mise sous tension .......................................Entrée

Niveaux de logique numérique

Tension externe
+5 V en sortie (200 mA maximum)

Minimum .......................................................+4,85 V

Typique ..........................................................+5 V

+2,5 V en sortie (1 mA maximum)........................+2,5 V

Précision de +2,5 V................................................0,25% maximum

Dérive de la température de référence ...................50 ppm/°C maximum

1   Ce document utilise les conventions de nom NI-DAQmx. ‘Open-drain’ est appelé collecteur ouvert et ‘push-pull’ est appelé 
signal actif.

Niveau Min Max

Basse tension en entrée 
Haute tension en entrée 
Courant de fuite en entrée

–0,3 V 
2,0 V 

—

0,8 V 
5,8 V 
50 μA

Basse tension en sortie (I = 8,5 mA)
Haute tension en sortie 
Signal actif, I = –8,5 mA 
Collecteur ouvert, I = –0,6 mA, 
Collecteur ouvert nominal, I = –8,5 mA, avec résistance de pull-up externe

— 

2,0 V
2,0 V 
2,0 V

0,8 V 

3,5 V 
5,0 V

—
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Compteur d’événement
Nombre de compteurs ............................................1

Résolution ..............................................................32 bits

Mesures de compteurs ...........................................Comptage de fronts (front descendant)

Direction de compteurs ..........................................Comptage montant

Résistance de pull-up .............................................4,7 kΩ à 5 V

Fréquence en entrée maximale ..............................5 MHz

Largeur d’impulsion haute minimale.....................100 ns

Largeur d’impulsion basse minimale.....................100 ns

Haute tension en entrée..........................................2,0 V

Basse tension en entrée ..........................................0,8 V

Interface de bus
Spécification USB..................................................USB 2.0 pleine vitesse

Vitesse du bus USB................................................12 Mbits/s

Spécifications d’alimentation
USB

4,10 à 5,25 VCC

Typique ..................................................80 mA

Maximale ...............................................500 mA

Arrêté en USB

Typique ..................................................300 μA

Maximale ...............................................500 μA

Caractéristiques physiques
Dimensions ............................................................Reportez-vous à la Figure 16.

Sans connecteur .............................................63,5 mm × 85,1 mm × 23,2 mm 
(2,50 pouces × 3,35 pouces × 0,91 pouces)

Avec connecteurs ...........................................81,8 mm × 85,1 mm × 23,2 mm 
(3,22 pouces × 3,35 pouces × 0,91 pouces)
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Figure 16.  Dimensions des périphériques NI USB-6008/6009

Poids

Sans connecteur .............................................54 g (1,9 oz)

Avec connecteurs ...........................................84 g (3 oz)

Connecteurs d’E/S .................................................Réceptacle USB de la série B, 
(2) connecteurs de type bornier à vis de 16 contacts

Câblage des bornes à vis................................16 à 28 AWG 

Couple pour bornes à vis ...............................0,22–0,25 N · m (2,0–2,2 livres · pouces)

Si vous devez nettoyer le périphérique, essuyez-le avec un chiffon sec.

Tensions de sécurité
Ne connectez que les tensions dans les limites suivantes.

Voie à GND............................................................±30 V max, catégorie de mesure I

La catégorie de mesure I correspond à des mesures réalisées sur des circuits n’étant pas directement 
reliés au système de distribution électrique RÉSEAU. RÉSEAU est un système d’alimentation électrique 
dangereux qui alimente un équipement. Cette catégorie correspond aux mesures de tensions de circuits 
secondaires particulièrement protégés. Des exemples de mesures de ce type incluent les niveaux de 
signaux, les équipements spéciaux, les parties à énergie limitée des équipements, les circuits alimentés 
par des sources basse tension régulées et l’électronique.

Attention N’utilisez pas ce périphérique pour les connexions de signaux ou des mesures dans les 
catégories de mesure II, III ou IV.

 

81,81 mm
(3,221 po)

76,09 mm
(2,996 po)

63,50 mm
(2,500 po)

72,65 mm
(2,860 po)

85,09 mm
(3,350 po)

23,19 mm
(0,913 po)

 NATIONAL 
INSTRUMENTS
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Environnement
Température (IEC 60068-2-1 et IEC 60068-2-2)

De fonctionnement.........................................0 à 55 °C 

D’entreposage ................................................–40 à 85 °C

Humidité (IEC 60068-2-56)

Dans l’environnement de fonctionnement .....5 à 95 % HR, sans condensation

Dans l’environnement d’entreposage.............5 à 90 % HR, sans condensation 

Degré de pollution (IEC 60664) ............................2

Altitude maximale..................................................2.000 m

À utiliser à l’intérieur uniquement.

Sécurité
Ce produit est conforme aux normes de sécurité suivantes en matière d’équipement électrique prévu 
pour les mesures, le contrôle et l’usage en laboratoire :

• IEC 61010-1, EN 61010-1

• UL 61010-1, CSA 61010-1 

Remarque Pour consulter des informations se rapportant aux certifications UL et d’autres 
certifications de sécurité, reportez-vous à l’étiquette du produit ou à la section Certification de 
produit en ligne.

Compatibilité électromagnétique
Ces produits sont conformes aux normes EMC suivantes en matière d’équipement électrique prévu pour 
les mesures, le contrôle et l’usage en laboratoire :

• EN 61326-1 (IEC 61326-1) : Émissions Classe A ; immunité de base

• EN 55011 (CISPR 11) : Groupe 1, émissions Classe A

• AS/NZS CISPR 11 : Groupe 1, émissions Classe A

• FCC 47 CFR Partie 15B : Émissions Classe A

• ICES-001 : Émissions Classe A

Remarque Aux États-Unis (selon le FCC 47 CFR), les équipements de Classe A sont conçus pour 
être utilisés dans des sites commerciaux ainsi que des sites à industrie légère et industrie lourde. En 
Europe, au Canada, en Australie et en Nouvelle-Zélande (selon le CISPR 11), les équipements de 
Classe A sont conçus pour être utilisés dans des sites à industrie lourde.

Remarque Les équipements du Groupe 1 (selon le CISPR 11) comprennent tout équipement 
industriel, scientifique ou médical ne générant pas de manière intentionnelle d’énergie par fréquences 
radio pour le traitement de matériel ou à des fins d’inspection/d’analyse.

Remarque Pour lire les déclarations et certifications CEM ainsi que des informations 
complémentaires, reportez-vous à la section Gestion de l’environnement.

Conformité CE
Ce produit remplit les principales conditions des Directives européennes applicables, comme suit :

• 2006/95/EC ; Directive portant sur les basses tensions (sécurité)

• 2004/108/EC ; Directive portant sur la compatibilité électromagnétique (CEM)
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Certification de produit en ligne
Pour obtenir des certifications de produits et consulter la Déclaration de conformité (DoC) de ce produit, 
allez sur ni.com/certification, faites une recherche par numéro de modèle ou par ligne de 
produits, et cliquez sur le lien approprié dans la colonne Certification.

Gestion de l’environnement
NI s’est engagé à concevoir et à fabriquer des produits en se préoccupant de l’environnement. 
À National Instruments, nous reconnaissons qu’il est bénéfique d’éliminer certaines substances 
dangereuses de nos produits, aussi bien pour nos clients que pour l’environnement.

Pour obtenir des informations supplémentaires sur l’environnement, reportez-vous à la page NI and the 
Environment, à ni.com/environment. Cette page contient les réglementations et directives 
concernant l’environnement auxquelles NI se conforme, ainsi que d’autres informations sur 
l’environnement qui ne figurent pas dans ce document-ci.

Déchets d’équipements électriques et électroniques (DEEE)

Clients de l’UE Ce symbole indique que les déchets font l’objet d’une collecte sélective différente 
de celle des déchets ménagers conformément à la Directive 2002/96/CE du Parlement européen et du 
Conseil du 27 janvier 2003 relative aux déchets d’équipements électriques et électroniques (DEEE). 
Au terme de leur cycle de vie, tous les produits doivent être envoyés à un centre de collecte et de 
recyclage des DEEE. Le respect des règles de mise au rebut des DEEE permet de réduire l’impact 
environnemental ainsi que les risques pour la santé liés aux substances potentiellement dangereuses 
généralement utilisées dans de tels équipements. Votre coopération à la mise au rebut adéquate des 
produits contribuera à l’usage efficace des ressources naturelles. Pour obtenir des informations 
relatives au plan de collecte et de recyclage disponible dans un pays particulier, reportez-vous au site 
http://www.ni.com/citizenship/weee.

Et maintenant ?
Cette section dresse la liste des endroits où trouver des exemples de programmes pour les périphériques 
NI USB-6008/6009 et toute documentation s’y rapportant.

Exemples de programmes
NI-DAQmx et le logiciel NI-DAQmx incluent des exemples de programmes pour vous aider à démarrer 
la programmation avec les périphériques NI USB-6008/6009. Vous pourrez modifier du code d’exemple 
et l’enregistrer dans une application, utiliser des exemples pour développer une nouvelle application ou 
ajouter du code d’exemple à une application existante.

NI-DAQmx
Pour trouver les exemples logiciels NI, allez à ni.com/frinfo et entrez l’info-code daqmxexp. Pour 
consulter d’autres exemples, allez sur ni.com/zone.

Pour exécuter des exemples sans matériel installé, utilisez un périphérique simulé NI-DAQmx. Pour 
obtenir des informations complémentaires, sélectionnez Aide»Rubriques de l’aide»NI-DAQmx»Aide 
MAX pour NI-DAQmx dans Measurement & Automation Explorer (MAX) et recherchez 
“périphériques simulés”.

RoHS
National Instruments  (RoHS)

National Instruments RoHS ni.com/environment/rohs_china
(For information about China RoHS compliance, go to ni.com/environment/rohs_china.)
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NI-DAQmx Base
Les exemples NI-DAQmx Base sont accessibles à partir de Démarrer»Tous les programmes»
National Instruments»NI-DAQmx Base»Examples.

Documentation associée
Tous les ensembles logiciels applicatifs et les drivers, incluent des informations relatives à l’écriture 
d’applications pour la prise de mesures et le contrôle de périphériques de mesure. Les références 
ci-après à des documents, impliquent que vous avez NI-DAQmx 9.3 ou versions ultérieures, et dans 
certains cas, la version 8.5 ou version ultérieure des logiciels d’application NI.

NI-DAQmx
Le guide de Démarrage rapide du NI USB-6008/6009 livré avec les périphériques NI USB-6008/6009 
décrit comment installer le logiciel NI-DAQmx et les périphériques et comment vous assurer que ces 
derniers fonctionnent correctement.

Le Readme NI-DAQ dresse une liste des périphériques, environnements de développement 
d’applications et logiciels d’application NI supportés par cette version de NI-DAQ. Sélectionnez 
Démarrer»Tous les programmes»National Instruments»NI-DAQ»Readme NI-DAQ.

L’Aide NI-DAQmx contient une présentation générale des API, des informations générales relatives aux 
concepts de mesure, aux concepts clés NI-DAQmx et aux applications courantes qui sont applicables à 
tous les environnements de programmation. Sélectionnez Démarrer»Tous les programmes»National 
Instruments»NI-DAQ»Aide NI-DAQmx.

NI-DAQmx Base (Linux/Mac OS X/LabVIEW PDA 8.x)
Le NI-DAQmx Base Getting Started Guide décrit comment installer votre logiciel NI-DAQmx Base, 
votre périphérique DAQ supporté par NI-DAQmx et comment vous assurer que votre périphérique 
fonctionne correctement. Sous Windows, sélectionnez Démarrer»Tous les programmes»National 
Instruments»NI-DAQmx Base»Documentation»NI-DAQmx Base Getting Started Guide.

Le document Getting Started with NI-DAQmx Base for Linux and Mac OS X Users décrit comment 
installer votre logiciel NI-DAQmx Base, votre périphérique DAQ supporté par NI-DAQmx et comment 
vous assurer que votre périphérique fonctionne correctement sur une machine Linux ou Mac.

Le  Readme NI-DAQmx Base dresse une liste des périphériques supportés par votre version de 
NI-DAQmx Base. Sous Windows, sélectionnez Démarrer»Tous les programmes»National 
Instruments»NI-DAQmx Base»NI-DAQmx Base Readme.

Le NI-DAQmx Base VI Reference Help contient une référence aux VIs et des informations générales sur 
les concepts de mesure. Dans LabVIEW, sélectionnez Aide»NI-DAQmx Base VI Reference Help.

Le NI-DAQmx Base C Function Reference Help contient une référence aux fonctions C et des 
informations générales sur les concepts de mesure. Sous Windows, sélectionnez Démarrer»Tous les 
programmes»National Instruments»NI-DAQmx Base»Documentation»C Function Reference 
Help.

Remarque Toute la documentation NI-DAQmx Base pour Linux est installée sous /usr/local/
natinst/nidaqmxbase/documentation.

Remarque Toute la documentation NI-DAQmx Base pour Mac OS X est installée sous 
/Applications/National Instruments/NI-DAQmx Base/documentation.
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LabVIEW
Si vous êtes un nouvel utilisateur, utilisez le manuel d’Initiation à LabVIEW  pour vous familiariser avec 
l’environnement de programmation graphique LabVIEW et ses fonctionnalités de base, utilisés pour 
construire des applications d’acquisition de données et de contrôle d’instruments. Pour ouvrir le manuel 
d’Initiation à LabVIEW , sélectionnez Démarrer»Tous les programmes»National Instruments»
LabVIEW»Manuels LabVIEW ou naviguez jusqu’au répertoire labview\manuals et ouvrez 
LV_Getting_Started.pdf.

Pour accéder aux informations relatives aux concepts de programmation LabVIEW, aux instructions 
détaillées pour utiliser LabVIEW ainsi qu’aux informations de référence sur les VIs LabVIEW, les 
fonctions, les palettes, les menus et les outils, utilisez l’Aide LabVIEW, disponible en sélectionnant 
Aide»Aide LabVIEW dans LabVIEW. Reportez-vous aux informations suivantes en cliquant sur 
l’onglet Sommaire de l’ Aide LabVIEW pour toute information relative à NI-DAQmx :

• Initiation à LabVIEW»Initiation à DAQ — Inclut des informations générales et un tutoriel pour 
apprendre à prendre une mesure NI-DAQmx dans LabVIEW en utilisant l’Assistant DAQ.

• Référence des VIs et des fonctions»VIs et fonctions d’E/S de mesure»Fonctions et VIs de 
DAQmx - Acquisition de données — Décrit les VIs et propriétés LabVIEW NI-DAQmx.

• Référence des propriétés et des méthodes»Propriétés NI-DAQmx contient des références aux 
propriétés.

• Prise de mesures — Contient des informations conceptuelles et procédurales dont vous avez 
besoin pour acquérir et analyser les données de mesure dans LabVIEW, ce qui inclut des mesures 
courantes, des mesures fondamentales, des concepts clés NI-DAQmx et des considérations 
spécifiques aux périphériques.

LabWindows/CVI
Le livre Data Acquisition de l’aide LabWindows/CVI Help contient Taking an NI-DAQmx 
Measurement in LabWindows/CVI, qui inclut des instructions détaillées sur la création d’une tâche de 
mesure en utilisant l’Assistant DAQ. Dans LabWindows/CVI, sélectionnez Help»Contents, puis 
choisissez Using LabWindows/CVI»Data Acquisition. Ce livre contient également des informations 
relatives à l’accès à des informations détaillées via l’Aide NI-DAQmx.

Le livre NI-DAQmx Library contenu dans l’ Aide LabWindows/CVI, contient une présentation et une 
référence des fonctions d’API pour NI-DAQmx. Sélectionnez  Library Reference»NI-DAQmx 
Library dans l’ Aide LabWindows/CVI.

Measurement Studio
Si vous programmez votre périphérique supporté par NI-DAQmx dans Measurement Studio en utilisant 
Visual C# ou Visual Basic .NET, vous pouvez, de manière interactive, créer des voies et des tâches en 
lançant l’Assistant DAQ à partir de MAX ou de Visual Studio .NET. Vous pouvez utiliser Measurement 
Studio pour générer le code de configuration basé sur votre tâche ou votre voie. Reportez-vous à l’Aide 
Assistant DAQ pour obtenir de plus amples informations sur la génération de code. 

L’aide NI Measurement Studio Help fait partie intégrante de l’aide de Microsoft Visual Studio. Pour voir 
ce fichier d’aide dans Visual Studio .NET, sélectionnez Measurement Studio»NI Measurement 
Studio Help. Pour toute information relative au développement avec NI-DAQmx, reportez-vous aux 
rubriques suivantes de l’aide NI Measurement Studio Help :

• Pour obtenir des instructions détaillées sur la manière de créer une application NI-DAQmx en 
utilisant le Measurement Studio Application Wizard et l’Assistant DAQ, reportez-vous à 
Walkthrough: Creating a Measurement Studio NI-DAQmx Application.
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• Pour obtenir de l’aide avec les méthodes et les propriétés NI-DAQmx, reportez-vous à 
NationalInstruments.DAQmx Namespace et NationalInstruments.DAQmx.ComponentModel 
Namespace.

• Pour obtenir de l’aide conceptuelle avec NI-DAQmx, reportez-vous à Using the Measurement 
Studio NI-DAQmx .NET Library et Developing with Measurement Studio NI-DAQmx.

• Pour obtenir de l’aide générale pour la programmation dans Measurement Studio, reportez-vous à 
Getting Started with the Measurement Studio Class Libraries.

Pour créer une application dans Visual Basic .NET ou Visual C#, effectuez les étapes suivantes :

1. Dans Visual Studio, sélectionnez File»New»Project pour lancer la boîte de dialogue New Project.

2. Dans le volet Project types, développez le nœud Visual Basic ou Visual C#, selon le langage dans 
lequel vous souhaitez créer le projet, puis sélectionnez Measurement Studio.

3. Choisissez un type de projet. Ajoutez des tâches DAQ dans cette étape.

ANSI C sans logiciel d’application NI
L’Aide NI-DAQmx contient une présentation générale des API ainsi que des informations générales sur 
les concepts de mesure. Sélectionnez Démarrer»Tous les programmes»National Instruments»
NI-DAQ»Aide NI-DAQmx.

La rubrique NI-DAQmx C Reference Help décrit les fonctions de NI-DAQmx Library, que vous pouvez 
utiliser avec les périphériques d’acquisition de données National Instruments pour développer des 
applications d’instrumentation, d’acquisition et de contrôle. Sélectionnez Démarrer»Tous les 
programmes»National Instruments»NI-DAQ»Support de code textuel»NI-DAQmx C Reference 
Help.

Langages .NET sans logiciel d’application NI
Avec la version 2.0 ou ultérieure de Microsoft .NET Framework, vous pouvez utiliser NI-DAQmx pour 
créer des applications en utilisant Visual C# et Visual Basic .NET sans Measurement Studio. Vous devez 
avoir Microsoft Visual Studio .NET 2005 ou version ultérieure pour que la documentation de l’API 
s’installe.

La documentation installée contient une présentation de l’API NI-DAQmx, des concepts et des tâches 
de mesure et une référence sur les fonctions. Cette aide fait partie intégrante de la documentation de 
Visual Studio. Pour afficher la documentation de NI-DAQmx .NET, naviguez vers Démarrer»Tous les 
programmes»National Instruments»NI-DAQ»Support de code textuel. Pour toute référence aux 
fonctions, reportez-vous aux rubriques NationalInstruments.DAQmx Namespace et 
NationalInstruments.DAQmx.ComponentModel Namespace. Pour obtenir de l’aide conceptuelle, 
reportez-vous aux sections Using the Measurement Studio NI-DAQmx .NET Library et Developing with 
Measurement Studio NI-DAQmx.

Pour obtenir les mêmes rubriques d’aide que pour Visual Studio 2005 et 2008, naviguez vers Help»
Contents, puis sélectionnez Measurement Studio à partir du menu déroulant Filtered By. Pour obtenir 
les mêmes rubriques d’aide que pour Visual Studio 2010, naviguez vers Help»View Help, puis 
sélectionnez NI Measurement Studio Help à partir de la section Related Links.

Cours de formation
Si vous avez besoin davantage d’aide pour démarrer le développement d’une application avec des 
produits NI, NI propose des cours de formation. Pour vous inscrire à un cours ou en obtenir une 
description détaillée, reportez-vous à ni.com/training.



 

CVI, LabVIEW, National Instruments, NI, ni.com, le logo de la société National Instruments et le 
logo de l’Aigle sont des marques de National Instruments Corporation. Veuillez consulter la 
rubrique Trademark Information sur ni.com/trademarks pour d’autres marques de National 
Instruments. The mark LabWindows is used under a license from Microsoft Corporation. 
Windows is a registered trademark of Microsoft Corporation in the United States and other 
countries. Les autres noms de produits et de sociétés mentionnés aux présentes sont les 
marques ou les noms de leurs propriétaires respectifs. Pour la liste des brevets protégeant les 
produits/technologies National Instruments, veuillez vous référer, selon le cas : à la rubrique 
Aide»Brevets de votre logiciel, au fichier patents.txt sur votre média, ou à National 
Instruments Patent Notice sur ni.com/patents. Reportez-vous à la page Export Compliance 
Information sur ni.com/legal/export-compliance pour consulter la politique de 
National Instruments en matière de conformité à la réglementation gouvernant le commerce 
international et pour savoir comment obtenir les codes de tarif douanier (HTS) et les numéros 
ECCN pertinents, ainsi que d’autres données relatives à l’import-export.
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Support technique sur le Web
Pour obtenir un support complémentaire, visitez le site ni.com/support ou zone.ni.com.

Remarque Vous pouvez télécharger ces documents sur ni.com/manuals.

Les spécifications DAQ ainsi que certains manuels DAQ sont disponibles au format PDF. Le logiciel 
Adobe Acrobat Reader avec fonctions de recherche et d’accessibilité 5.0.5 ou version ultérieure doit être 
installé sur votre ordinateur pour que vous puissiez afficher la documentation au format PDF. 
Reportez-vous au site Web d’Adobe Systems Incorporated au www.adobe.com pour télécharger 
Acrobat Reader. Consultez la bibliothèque des manuels des produits National Instruments sur ni.com/
manuals pour vous procurer la documentation la plus récente.

Support
Le site Web de National Instruments est une source complète de support technique. Sur ni.com/
support vous pouvez accéder à toutes les ressources de support technique disponibles, qu’il s’agisse 
d’un dépannage, de ressources d’auto-assistance technique pour le développement d’applications ou 
d’une assistance technique fournie par les ingénieurs d’application NI par téléphone ou e-mail.

Une déclaration de conformité, ou DoC, est notre déclaration de conformité avec le Conseil des 
communautés européennes ; celle-ci s’appuie sur la déclaration de conformité du fabricant. Ce système 
confère à l’utilisateur une protection en matière de compatibilité électromagnétique (CEM) et de 
sécurité des produits. Vous pouvez obtenir la DoC de votre produit en visitant le site ni.com/
certification. Si votre produit supporte l’étalonnage, vous pouvez obtenir le certificat 
d’étalonnage relatif à votre produit sur ni.com/calibration.

Le siège social de National Instruments est situé à l’adresse suivante : 11500 North Mopac Expressway, 
Austin, Texas, 78759-3504, États-Unis. National Instruments compte aussi des filiales dans le monde 
entier pour répondre à vos besoins de support. Pour obtenir le support téléphonique aux États-Unis, 
créez votre requête de service à ni.com/support et suivez les instructions d’appel ou composez le 
512 795 8248. Pour obtenir le support téléphonique en dehors des États-Unis, naviguez vers la section 
Worldwide Offices de ni.com/niglobal afin d’accéder au site Web de votre filiale, qui dispose de 
coordonnées, numéros de téléphone du support, adresses email et événements d’actualité, à jour.
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